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Objectives 
This document provides a series of exercises in creating a simple HTML document. When you have completed 
these exercises you should be able to: 

•  Create a simple HTML document 
•  Understand simple HTML tags 
•  View HTML documents using a WWW browser such as Netscape 

Pre-requisites 
This document assumes that you are familiar with Microsoft Windows and use of a WWW browser. 

Format Conventions 
The following format conventions are used in this document. 

Computer input is shown in a bold Courier font  http://www.netskills.ac.uk/ 
Computer output and menu names are shown in a 
Courier font 

Save 

Items that you must replace are shown in italics.   Enter your username.   

Site-Specific Features In This Document 
This document assumes that Netscape and Notepad are available on the MS Windows desktop.  

Copyright 
This copyright material has been developed for the UK higher education community with central funding and 
is made available to that community at 100% discount. It may be copied and/or adapted for non-commercial 
academic purposes within UK higher education establishments subject to the following conditions: 

•  that only a nominal charge not exceeding cost recovery is made for the supply or use of any such 
copy or adaptation; and 

•  that this copyright notice is included in any such copy or adaptation. 

Netskills reserves the right to change this policy. Any other use is prohibited without the prior permission of 
the copyright owner, Netskills, University of Newcastle. 

Contact Information 
Netskills, University Computing Service, University of Newcastle, Newcastle upon Tyne, NE1 7RU. 
Email: netskills-admin@netskills.ac.uk 

Netskills is a trademark of Netskills, University of Newcastle. 

Print Record     Document: authfeb-00  Printed: February 8th, 2000.  
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Task 1   Getting Started 
Objectives To access the Microsoft Windows 95 desktop and to start up the applications to be used in the 

following exercises. 

Method You will run Notepad and Netscape - a World Wide Web browser. 

Comments The Windows 95 desktop and Netscape start-up screen may differ depending on your local set-
up. 

 

Activity 1.1 Familiarise yourself with the Windows 95 desktop, then, from the Start menu in the Task Bar, 
choose Programs/Accessories/Notepad. The Notepad program will start and appear as shown in 
Figure 1-1:  

 

Activity 1.2 Now open Netscape, the web browser, by choosing Programs/Netscape Communicator/Netscape 
Navigator from the Start menu. The Netscape program will appear as shown in Figure 1-2. 

Figure 1-2  The Netscape Screen 

Position the Notepad and Netscape windows so that you can see a section of both windows at 
any time, allowing you to switch between them using the mouse when necessary.  

 

Figure 1-1.  
The Notepad Program 
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Task 2 Creating A Simple HTML 
Document 

Objectives To create and view a simple HTML document. 

Method You will create a simple HTML document using Notepad and then view the document using 
Netscape. 

Comments Notepad is a simple Windows editor which can be used to create and edit text files. 
 

Activity 2.1 In the Notepad window type in the following text: 

<html> 
<head> 
<title>My First HTML Document</title> 
</head> 
<body> 
This is my first HTML document. 
</body> 
</html> 

Activity 2.2 Select the Save option from Notepad’s File menu and save the file as test.htm in the 
directory My Documents on the C: drive. 

Activity 2.3 Switch to the Netscape program by clicking on any part of its window. From the File menu 
select the Open Page option. Then click on the Choose File button and select the file you 
created in the previous activity from the My Documents directory.  

 

 

 

 

 

 

 

The document should be displayed as shown in Figure 2-2. 

 

The TITLE is
displayed here

The location of the file on
your hard disc is shown in the
Location box

 
  

Figure 2-2  HTML Document Displayed Using Netscape 

 

Figure 2-1  Choosing a File 



3 

Task 3 Adding Text To Your HTML 
Document 

Objectives To add some paragraphs to your simple HTML document. 

Method You will add some paragraphs separated by carriage returns which you will view. You will then 
add the <p> paragraph tag. 

Comments Paragraphs are delimited by the <p> and </p> HTML tags. 
 

Activity 3.1 Return to Notepad and add the following text (shown in bold): 
<html> 
<head> 
<title>My First HTML Document</title> 

</head> 
<body> 
This is my first HTML document. 
 
I have created this document using Notepad. 
 
John Smith replace John Smith with your name 
</body> 
</html> 

Save the file using the Save option from the File menu.  

Activity 3.2 Return to Netscape and click on the Reload button. The following screen will be displayed: 

 

Figure 3-1  Document Displayed as Single Paragraph 

Note Notice how the text is displayed in a single paragraph. 

Activity 3.3 Return to Notepad. Enclose each paragraph with the <p> and </p> start and end tags: 

<p>This is my first HTML document.</p> 
 
<p>I have created this document using Notepad.</p> 
 
<p>John Smith</p> 

Save the file. 

Activity 3.4 Return to Netscape and click the Reload button. Notice that the individual paragraphs are now 
displayed correctly. 

Note WWW browsers use the <p> paragraph tag to identify paragraphs. Carriage returns normally 
have no effect on the way in which an HTML document is displayed. 
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Task 4 Adding Headings To Your 
HTML Document 

Objectives To insert sections headings in the HTML document. 

Method You will add <h1> and <h2> header tags. 

Comments Headers should be delimited using the <hn> and </hn> paragraph tag. Up to six levels of 
headings can be given. 

 

Activity 4.1 Return to Notepad and add the following text shown in bold: 
<html> 
<head> 
<title>My First HTML Document</title> 
</head> 
<body> 
 
<h1>HTML Authoring Course</h1> 
<h2>My First Document</h2> 
 
<p>This is my first HTML document.</p> 
 
<p>I have created this document using Notepad.</p> 
 
<p>John Smith</p> 
</body> 
</html> 

Then save the file. 

Activity 4.2 Return to Netscape and click the Reload button. Notice that the headers are displayed 
differently from the main text: 

 
Figure 4-1  Display of <h1> and <h2> Tags   
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Task 5 Using Lists 
Objectives To add a bulleted list to your HTML document. 

Method You will add <ul>, <ol>, <li>, </ol> and </ul> tags. 

Comments The <ul> tag is used to define the start of an unordered list. The <ol> tag is used to define the 
start of an ordered list. The <LI> tag is used to define the items in the list. The </ul> or 
</ol> tags define the end of the unordered or ordered list. 

 

Activity 5.1 In Notepad, add the following text (shown in bold): 
... 
<p>I have created this document using Notepad.</p> 
 
<h2>Summary</h2> 
<p>So far I have learnt:</p> 
<ul> 
<li>How the TITLE tag is displayed 
<li>The role of the paragraph tag 
<li>The use of the h1 and h2 tags for headers 
</ul> 
 
<p>I am about to learn the following three things: 
<ol> 
<li>About unordered (bulleted) lists 
<lI>About ordered (numbered) lists 
<li>That the paragraph end tag can be omitted. 
</ol> 
 

Then save the file. 

Note The </p> tag has been omitted from the sentence: three things:</p> The end paragraph 
tag is optional. 

Activity 5.2 Return to Netscape and click the Reload button. Notice how the unordered and ordered lists 
are displayed. 

 
Figure 5-1  Display of Ordered and Unordered Lists   

Activity 5.3 Create another ordered list using the <ol>, <lI> and </ol> tags. Make a list of any problems 
you have experienced, or any questions you have at this point. 
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Task 6 Formatting and Logical Tags 
Objectives To demonstrate the effect of various formatting and logical tags in HTML. 

Method You will add <b> (bold), <i> (italic) and <strong> tags. 

Comments Formatting tags such as <b> and <i> give you control over the appearance of a document. 
However logical tags can define the role that text has in a sentence. 

 

Activity 6.1 Return to Notepad and add the italic <i> tag to the text as shown in bold: 

<p>This is my <i>first</i> HTML document.</p> 

Save the file and then go to Netscape and click the Reload button. Notice how the word first is 
displayed in italics. 

Activity 6.2 Return to Notepad and change the italic tag to the bold <B> tag as shown: 

<p>This is my <b>first</b> HTML document.</p> 

Save the file and then and click the Reload button in Netscape. Notice how the word first is 
displayed in bold. 

Activity 6.3 Return to Notepad and change the bold tag to the strong <strong> tag as shown: 

<p>This is my <strong>first</strong> HTML document.</p> 

Save the file and then go to Netscape and click the Reload button. Notice how the word first is 
displayed. 

Note Although formatting tags such as <b> and <i> give you, the author, control over the appearance 
of your document, structural tags, such as <strong> define the role the text has in a sentence. 
For example the sentence You must <strong>not</strong> press button A could be 
rendered by an audio-enabled browser used by the visually impaired by a change in the emphasis 
in the tone of the voice. In contrast the sentence You must <i>not</i> press button A could not 
be interpreted in this way. 

Activity 6.4 Line Breaks 

Insert a line break tag <br> in the middle of a sentence and compare its effects with a paragraph 
tag used previously. 

Activity 6.5 Pre-formatted Text 

Sometimes you will want the spaces, tabs and general layout of text to be preserved in an HTML 
document. For example if you have data or text in columns. To achieve this, the text must be 
enclosed in the Pre-formatted tags, <pre> and </pre>. 

Type in the following small table using tabs to separate the columns and surrounding it with 
preformatted tags: 

<pre> 

 Col. 1 Col. 2 Col. 3 

 1.1  2.1  3.1 

 1.2  2.2  3.2 

</pre> 

Save the file, then reload it into Netscape to see how it looks. 
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Activity 6.6 Indented Text 

Indent a piece of text like a quotation using the blockquote tags: 

This is normal text 

<blockquote> 

This paragraph will appear indented in Netscape as it is 
enclosed in blockquote tags. Any spaces       tabs or  
line breaks  

will be ignored.</blockquote>  

Back to normal text 

 

Figure 6.1  Blockquoted Text 
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Task 7 Using Hypertext Links 
Objectives To create a hypertext link in your HTML document. 

Method You will add the <a> (anchor) tag to provide a link to the College’s home page. 

Comments The <a> anchor tag can provide links to files held on computer systems around the world. 
 

Activity 7.1 Return to Notepad and add the following text: 
 
<a href="http://www.qmw.ac.uk/"> Queen Mary and Westfield 
College</a> 

Save the file and then view it in Netscape. Notice how the words Queen Mary and 
Westfield College (i.e. the text contained between the <a..> and </a> tags) is 
displayed differently from the rest of the text (often in a different colour or underlined). 

Note Notice that the <a> tag has the format <a href="http://server_name/ 
pathname"> The server_name is the name of the computer system you wish to access and 
pathname normally refers to the name of the file you wish to retrieve and the directory in 
which it is located. 

Activity 7.2 Click on the highlighted words Queen Mary and Westfield College with the left 

mouse button. You will be taken to the QMW home page as shown below: 

Figure 7-1  QMW Home Page 

Activity 7.3 Click on the View menu and select the Page Source option. Examine the HTML used in the 
document you are viewing. It may appear complicated but try to identify some hypertext links in 
the HTML source. Close the source window when you have finished. 

Activity 7.4 Click on the Back option of Netscape (which is often an icon, or a menu option located in the 
Go or Navigate menu).  
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Activity 7.5 Start a new file in Notepad and type in the following lines:  

<html> 
<head> 
<title>Mydoc</title> 
</head> 
<body> 
<a href="test.htm"> Go to test.htm</a> 
</body> 
</html> 

Save this file as mydoc.htm, then switch to Netscape and open it using File/Open 
Page/Choose File as before. The line you have just typed should appear in blue as a link. 
Click on the blue text and you should go to your original file (test.htm). 

Activity 7.6 Now re-open your original file (test.htm)in Notepad and put in a link pointing to 
mydoc.htm Try the links to make sure they work. 

Activity 7.7 To link to a specific part of a document the destination text must have an anchor tag and a name.  

Go back to editing the first file, test.htm, and place the following line half way down the 
document: 

<p><a name="anchor1"> This is an anchor called  anchor1 
</a> in test.htm</p> 

Now insert the following line near the top of the file: 

<a href="#anchor1"> Go to anchor1</a> 

Save the changes and try out the link to anchor1. 

Note To make the text of the named anchor appear at the top of the screen, there should be at least a 
pageful of text below it. 

 

Activity 7.8 Open the second file, mydoc.htm, in Notepad once more. Go to the href line and change it to: 

<a href="test.htm#anchor1">Anchor1 in test.htm </a> 

 Save the change, open the file mydoc.htm in Netscape and try the link to make sure it goes 
straight to the named anchor in test.htm.  

 

If you have time... 

Activity 7.9 There are some special href formats. For example, the Hypertext Link to Email Dialogue Box 
which, when activated, will open up an email dialogue box allowing the caller to send mail using 
Netscape's own mail interface. 

Insert the following construct and try it out: 

Please mail any comments to 

<a href="mailto:your-emailname@qmw.ac.uk"> 
 your-emailname@qmw.ac.uk</a> 

Note It is recommended that the email address is shown as the link (as in the example) as not all 
browsers accept the mailto construct and readers may need to copy the email address for use 
with their own mail system. 
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Task 8 Adding Images 
Objectives To add an image file to your HTML document. 

Method You will use the <img src="image_filename"> tag to include an image. 

Comments The <img src=> tag can provide a link to images. You will normally use GIF, JPEG or PNG 
image formats in your HTML documents. 

 

Activity 8.1 The first activity in this section is to acquire an image file to use.  

In Netscape, return to the QMW public home page (www.qmw.ac.uk). You should be able to do 
this by selecting it from the Go menu. If not, type the URL into the Location box and press the 
Enter key. 

When the page has loaded, point to the crown logo at the 
top and hold down the right mouse button. The drop 
down menu in Figure 8-1 will appear. 

Select the option Save Image As..  from the menu 
and save the file as logo.gif in the My Documents 
folder on the C: drive. 

Activity 8.2 Return to Notepad and add the following text to 
test.htm: 

<img src="logo.gif" ALT="QMW 
Logo"> 

Save the file and then go to the browser and click the 
Reload button. The QMW logo will appear in your 
document, as shown below. 

 
Figure 8-2  Display of the QMW Logo (logo.gif) 

Note The file logo.gif should be in the My Documents folder – the same one as the file 
test.htm - so only the filename is required as a URL. 

The alt="QMW Logo" attribute is used in order to provide a textual alternative for browsers 
which cannot load images, or when loading of images is disabled. 

Activity 8.3 Go back to Notepad and add the height and width attributes to the image link: 

<img src="logo.gif" height=100 width=256 alt="QMW Logo"> 

Save the file and then view it in Netscape. The logo should appear half the size it was before. 

Note Resizing the image using the height and width tags does not alter the size of the file itself. 
This means that it will still take the same amount of time to load. To make the image load faster 
you need to resize it using a graphical manipulation package. 

Figure 8-1 Copying an  
Image or Location  
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Activity 8.4 Return to Notepad and add the following text: 

<h2> Using the ALIGN attribute for an image</h2> 
<img src="logo.gif" alt="QMW Logo" align="top">This text is 
aligned to the top. 
<hr> 
<img src="logo.gif" alt="QMW Logo" align="middle">This text 
is aligned to the middle. 
<hr> 
<img src="logo.gif" alt="QMW Logo" align="bottom">This text 
is aligned to the bottom. 
<hr> 

 
Save the file using the Save option from the File menu. Return to Netscape and click the 
Reload button. Look at the three images and notice the position of the text in each case. 

Activity 8.5 Return to Notepad and add the text shown below:. 
 
<h2> Using an image as a hyperlink to a HTML document</h2> 
<a href="http://www.qmw.ac.uk/"><img src="logo.gif"></a> 
<hr> 

  

View the file in Netscape. Notice that the image has a coloured border around it, and as you pass 
the mouse over the image the URL of the pages to be displayed appears in the status bar. Select 
the image hyperlink. 

  

If you have time...... 

Activity 8.6 Enter the URL: 

http://www.ncl.ac.uk/images/gifs4us/ 

into the Location box in Netscape and press the Enter key.  

Move the cursor over one of the images and then hold the right mouse button down. Click on 
the Copy Image Location option of the drop down menu.  

Return to Notepad and add the 

<img src="paste image location here">  

tag,  replacing the text in italics by pasting in the image location or URL.  

Save the file and try out the link in Netscape. 

Activity 8.7 Look at the comprehensive collection of icons and graphics at the following URLs: 

http://www.iconbazaar.com/ 

http://ftp1.rad.kumc.edu/icons/icons.htm 
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Task 9 Creating a Simple Table 
Objectives To create a simple table in your HTML document. 

Method You will use a number of basic table tags. These will include <table>, <tr>, <th> and 
<td>. 

Comments Tables may not be supported by older versions of some browsers. They are however a useful 
tool in organising page layout. 

 

Activity 9.1 Return to Notepad. Select a suitable place in the body of your document for placing a table and 
add the following text: 

<table border> 
<tr><th>Contents</th></tr> 
<tr><td>Task 1</td> 
<td>Getting Started</td> 
<td>Page 1</td></tr> 
</table> 

Activity 9.2 Save your document, return to Netscape and 
click the Reload button. The table should 
now appear in your document as shown in 
Figure 9-1. 

Note The <table>...</table> tag encloses 
the whole table. Here we have used the 
additional attribute border, this displays the 
outline of the rows and columns. The <tr>...</tr> tag is for the table row and within this 
you use the <td>...</td> tag to enclose table data (a cell value).  

 The tag <th>...</th> encloses a column or row header inside a row.  
The <th> and <td> elements can have align and span attributes, for example <th 
colspan=3> would span the header entry across three columns and <td align=LEFT> 
would position the cell data to the left hand side.  

 The closing tags </tr>, </th> and </td> are not actually required 

Activity 9.3 Return to your document in Notepad and add some more rows to the table. 
Try placing the Contents header across three columns. 
What happens when you omit the border attribute? 

 

If you have time... 

Activity 9.4 Look at the examples of table layout at the URL: 
http://www.netscape.com/assist/net_sites/table_sample.html 

 
Figure 9-1  Display Of A Table 
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Task 10 Publishing Your Document 
Objectives To publish the HTML document you have created. 

Method You will use a file transfer program to upload the file onto a web-server (known as alpha) 

Comments WS_FTP is an easy-to-use file transfer program with a typical Windows interface. There are 
many other such programs available, many of them freeware or shareware. 

 

 

Activity 10.1 Go to the Start menu and choose WS_FTP from the Programs section.  

Note the details in the Session Properties dialogue box: 

 

The name of the server to which you will upload the file is alpha.qmw.ac.uk. 

 The user ID and password are already entered, so all you need to do to connect to the server is 
click the OK button. 

 

Activity 10.2 When a successful connection has been made the WS_FTP window will appear like this: 

 

 The left side of the window lists the files and folders on the PC (Local System). Make sure that 
this shows the C:\My Documents folder.  

The right side of the window lists files and directorois on the server. Make sure that this shows 
the public_html directory. 
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Select the file you want to upload by clicking on it once, then click on the right arrow button in 
the middle of the window. 

You should now see the file appear in the list of server files on the right. 

 

Activity 10.3 Go back to Netscape and type the URL of the file you have just uploaded into the Go To: or 
Location box and press Return. 

The URL of the document will be like this: 

http://www.qmw.ac.uk/~userID/filename 

 where userID is that used for logging in to the server and filename is the actual name of the file 
that you uploaded. 

Note: It is not necessary to include the public_html directory in the URL as the server takes that 
part for granted when interpreting the ~userid component of the address. 

 

Activity 10.4 When you have successfully accessed your web document in Netscape, go back to WS_FTP to 
close the connection with the server and quit by clicking on the Exit button. 
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Task 11 Checking Your HTML 
Objectives To validate an HTML document. 

Method You will use an web-based validation service. 

Comments Use of HTML validation is strongly recommended. This service allows the testing of a published 
document. 

 

Activity 11.1 Return to Netscape and type the following URL into the Location/Go to box: 

http://www.mirror.ac.uk/services/validator/ 

Then press the Enter key.  

The HTML Validation Service provided by the UK Mirror Service will be displayed.  

 Type the URL of your web page in the Location box and click on the 'Validate this 
page' button. 

 

Activity 11.2 You will probably find that the first error given in the validation results is a missing Doctype 
statement which should appear as the first line of a strictly conforming HTML document.  

 Try editing the file, inserting the following statement at the top: 

<!DOCTYPE PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"> 

 Save and transfer the file again to the server, then re-submit it for validation. 
 

Activity 11.3 See if you can eliminate any other errors in your HTML 
 

Note Validation is very important. It is possible to create an HTML document, which may look 
correct when displayed by a WWW browser, but contains errors. For example a document 
containing an incorrect header end tag would give incorrect results if an automatic table of 
contents were to be generated. 
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Task 12  Finding Out More 
Objectives To find out more about HTML. 

Method You will access information available on the WWW to find out more about HTML. 

Comments The sites below are just a few of those providing information on all aspects of the Web.  
 

Activity 12.1 You might like to look at the information available at some of the following URLs. 

 

I) Tutorials and Guides: 

Getting Started With HTML 
http://www.w3.org/MarkUp/Guide/ 

A Beginner's Guide To HTML 
http://www.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimer.html 

Crash Course in HTML  
http://www.w3-tech.com/crash/CrashCourse.html 

Creating HTML  
http://www.rose-hulman.edu/~bornemjd/chtml/html.html 

II)  Reference: 

The Barebones Guide to HTML  
http://werbach.com/barebones/barebone.html 

The WWW Help Page 
http://werbach.com/web/wwwhelp.html 

The HTML Language 
http://union.ncsa.uiuc.edu/HyperNews/get/www/html/lang.html 

HTML Tag List 
http://utopia.knoware.nl/users/schluter/doc/tags/index.html 

III) Style and Design: 

Style Guide for Online Hypertext 
http://www.w3.org/Provider/Style/Overview.html 

Guide to Good Practices for WWW Authors (JISC/SIMA Report)  
http://www.man.ac.uk/MVC/SIMA/Isaacs/toc.html  

IV) HTML Standards: 
http://www.w3.org/pub/WWW/MarkUp/ 

V) Complete Guide to the World Wide Web and HTML: 

The World Wide Web Information Pack 
http://www.abdn.ac.uk/diss/webpack/ 

 

Activity 12.2 If you find that any of these links are out of date, please let me know! 
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Appendix 1  Guidelines for Good Practice 
 

•  Consider the needs and facilities of your users.  

•  Take into account the cost of maintaining WWW data. 

•  Consider whether HTML meets the requirements of your user group. 

 

•  Use the Doctype declaration to declare the type of HTML used. 

•  For maximum portability and usability, use standard HTML. 

•  Validate your HTML mark-up. 

•  Make sure your documents are usable on a range of browsers. 

•  Do not use non-standard extensions in documents intended for general readership. 

•  Provide alternative options to non-standard elements. 

•  Use the paragraph tag to enclose paragraphs, not to create space. 

•  Use heading levels in their natural order, starting with Heading Level 1 at the top of the 
document, and proceeding one step at a time from one level down to the next. 

•  Do not use multiple DD tags with one DT tag. 

•  Avoid overlapping tags. 

•  Do not embed structural tags in other elements such as lists or anchors. 

•  Using relative URLs in anchors facilitates moving collections of data. 

•  Cite URLs for directory entries correctly. 

 

•  Use a standard classification scheme. 

•  Give a consistent appearance to a collection of documents. 

•  Use a template as a starting point for composing documents. 

•  Provide flexibility. 

•  Provide navigational aids at all times. 

 

•  Always give a concise, meaningful title in the HEAD part of the document. 

•  Limit pages to a manageable size. 

•  Use links to enrich your document, but let it speak for itself too. 

•  Don't use 'Click here' for links. 

•  Supply contextual information about links. 

•  Make regular checks of the links in your documents. 

•  Use graphics effectively to enhance yourdo not include large graphics files as inline images. 

•  Let the user choose whether or not to view large graphics files. 

•  Test graphics on different monitors. 

•  Always provide an alternative to images. 

•  Provide a text alternative to hyperlinked graphics. 

•  Re-use images in preference to using new ones. 
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•  Check documents on a regular basis. 

•  Provide author or publisher information in your documents. 

•  Test scripts for effective functioning. 

 

•  Do not say anything to harm the reputation of others. 

•  Copyright does apply to WWW pages. 

•  The default is that copyright belongs to the author/publisher. 

•  Obtain consent if you want to use other's material. 

•  Your web pages are your property (or your institution's) unless you give them away. 

•  Obscene and pornographic material is likely to be unacceptable legally and institutionally, as 
well as offensive to the average web user. 

•  Obtain permission before including personal information or a photograph. 

•  Be aware that personal information is protected by legislation. 

 

 

Appendix 2  Document Checklist 
 

Here is a list of things to do when you have prepared your document:  

 

1. Read through it carefully. Look at:  

•  spelling  

•  grammar  

•  clarity of expression  

•  structure  

•  usability  

2. Check out the graphics  

•  do they enhance the content?  

•  are they aesthetically pleasing? (if you can't tell, ask someone who can)  

•  are images of manageable size? (downloading time)  

•  is the text easily readable? (avoid busy backgrounds, watch colour combinations of text 
and background)  

3. Test it in different environments:  

•  at least three browsers, including one plain text one  

•  different monitors with varying resolution, size and colour capability  

4. Run it through an HTML validation program.  

5. Have someone else view it and give you comments.  

6. Announce it. 

 

Appendices are copied from ‘Guide to Good Practices for WWW Authors’ – a JISC/SIMA report by Margaret 
Isaacs (http://www.man.ac.uk/MVC/SIMA/Isaacs/toc.html) 


